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トラック 

各プロジェクトには、クリップを置いたりオーディオ入力を録音したりするためのトラックがあります。クリップを置い

たり録音が終了したりすると、直ちにクリップを表すブロックがトラック上に現れます。トラック自体は、タイムスケー

ル・バーの下に水平に広がり、複数のトラックは垂直に積み重ねられます。 
 
各トラックの左側には、トラックに関する様々な情報表示とコントロールを行うトラック・ヘッダーがあります。 

  
いくつかのオペーションは、選択したトラックにのみ適用されます。トラックを選択するには、トラック・ヘッダー部分

をクリックします。その際、トラックの機能に関するボタンを押して変更してしまう恐れがあるので、トラック・ネーム

の箇所をクリックすることをお勧めします。 
  

トラック番号 

トラック番号は接続しているミキサーのストリップに従って付番されます。プロジェクトのミキサーがMonoチャンネ
ルのみの10チャンネルの構成だった場合、編集トラックの番号は上から1-10番になります。 
 
ミキサーのマルチチャンネル・ストリップへ接続されたトラックは、下図のように先頭のトラックにストリップ番号が表

示され、それ以外はトラック構成（L,RやL,R,C,Ls,Rs,Lfeなど）が表示されます。マルチチャンネル・トラック上の
Mute, Solo, Rec Readyなどのボタンやトラック・ネームの変更などは、すべて連動して動作します。 
 

 

トラックの追加 

デフォルトで、新しいプロジェクトはミキサー構成で定義した入力チャンネルと同数のトラックを作成して開きます。 
プロジェクトを作成した後でも、トラックの追加と削除は手軽に行えます。 
 
 

ペーストによるトラック作成 

Media Managementまたはライブラリーから、トラックの存在していないタイムラインの空白エリアへクリップをコピ
ー＆ペーストあるいはドラッグ＆ドロップすると、既存トラックの下に自動的にトラックを追加します。 
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新しいトラックの作成 

新しいトラックは、任意のトラックを選択している場合はその下に挿入され、何も選択していない場合は最後トラッ

クの下に追加されます。タイムラインへトラックを追加するには、Tracks > New Audio Trackを選択します。 
または、トラック・ヘッダー下の空白エリアで右クリックし、New Audio Trackを選択します。 
 

 

 

トラックのみの作成／トラック＆ストリップの作成： 
シンプルにMonoトラックだけ作成するには、Create only Tracksのラジオボタンをチェックし、Number of 
Tracksのボックスに必要なトラック数を入力してOKボタンをクリックします。この時、デフォルト名のAudioと昇順
の1が付番されて“Audio 1”とトラック・ネームが付いてトラックが作成されます。 

  
 もし、ミキサーストリップを同時に作成したい場合はCreate Strips and Tracksのラジオボタンをチェックします。 

Number of Tracksのボックスに必要なトラック数を入力して、ストリップの種類を選択します。（次ページ参照） 
Pyramixは現在４種類のストリップに対応しています。デフォルトはMonoです。 
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ストリップの種類は、ドロップダウンリストから選択することができます。 

 
  

Mono以外を選択した場合、選択したストリップの種類に合わせて適切な数のトラックが作成されます。 
ストリップの入出力は、Strips Channels Typeのドロップダウンリストで選択されたチャンネルの割り当てに合わ
せてタグ付けされます。 
 

 
  

6チャンネルの例は上図の通りです。MSの<No Type>を選択した場合、ストリップI/OはC（Centre）およびW
（Width）とタグ付けされます。 
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トラックの種類 

概 要 

すべてのトラックはシングル・チャンネルです。ただし、作成したストリップ・チャンネルの種類によって、自動的に名

前，オートメーション，ソロ，ミュート，モニター・モード，Recordオード，波形表示がリンクします。 
  

オーディオトラック 
マルチチャンネルのトラックを作成した場合、関連するファンクションの動作は自動的にリンクします。 
（オートメーション，ソロ，ミュート，モニター・モード，レコード・モード，波形表示など） 

  
デフォルトで、ステレオまたはマルチチャンネル・トラックには（下図のように）先頭のトラック・ヘッダーだけに全て

のファンクション・ボタンが表示され、それ以外のトラックはトラック構成（L,RやL,R,C,Ls,Rs,Lfeなど）と“+”ボタン
が表示されます。この “+”ボタンをクリックすると、トラック・ヘッダーの残りのボタンが表示されます。この時、“+”
ボタンの表示は“-”ボタンに切り替わります。 “-”ボタンをクリックすると、トラック・ヘッダーのファンクション・ボタン
は非表示に戻ります。 
 

 

 

トラックの名前と番号 

 
 

多くのトラック＆ストリップを作成する場合、自動的に名前付けと付番（昇順）が行えます。 
     

z No Increment すべてのトラックは、同じ名前が付いた状態で作成されます。 
すなわち、Prefix:のテキストボックスに入力した名前のみ（番号なし）が付きます。 

  
z Increment by Track トラックには、Prefix:のテキストボックスに入力した名前と、番号が付きます。 

例えば、Atomと入力して5.1ｃｈのGPストリップをL-C-R-Ls-Rs-Lfeフォーマットで作
成すると、6つのトラックが追加されます。この時、Increment starts at:のボックス
に33と設定した場合、トラック名はAtom33，Atom34～38と自動的に名前が付き
ます。ストリップには、Prefix:で入力した名前が付きます。 

     
z Increment by Track/Strip  トラック/ストリップには、すべてAtom33と名前が付きます。 
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Trackグループ 

Trackグループには、以下の３つのオプションがあります： 

 
Don’t Group Tracksは、新規トラックに関してTrackグループを作成しません。 

       
Group all Tracks togetherは、新規トラックをすべて１つのTrackグループにします。 
 
Group Tracks per Stripsは、新規トラックをストリップ別に分けてTrackグループにします。 
例えば、5.1chのGPストリップ2本作成した場合、６トラック毎に2つのTrackグループを作成します。 
 
 

トラックとストリップの連動 
 
Tracks > Synchronize Tracks & Stripsメニューを有効にします。 
 
z ミキサーのConfigureページなどでストリップを作成/削除/移動すると、トラックも連動（作成/削除/移動）しま

す。 
 
z ストリップを削除した場合、接続しているトラックに何もクリップがない（空トラック）場合だけトラックが削除され

ます。トラックにクリップが存在する場合は、ミキサーとの接続が解除された状態でトラックは残ります。 
 
 

トラックの削除 

シングル・トラック 
トラックを削除するには、はじめに削除したいトラックを選択します。次に、Tracks > Deleteメニューを選択します。
トラックとトラック上に置かれていたすべてのクリップは削除されます。この時に削除されるのはクリップのみで、オ

リジナルのMediaファイルが削除されるわけではありません。 
  

マルチプル・トラック 
Tracks > Delete to Lastメニューを選択すると、選択したトラック以降にあるすべてのトラックを一度に削除するこ

とができます。 
 
トラックの追加と削除に関するメニューは、トラック・ヘッダー部分の右クリック・メニューからも利用できます。 
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トラック/ミキサー間のルーティング 
ミキサーを作成すると、Pyramixはミキサーの入力ストリップ数（チャンネル）と同じ数のトラックを自動的に作成し
ます。 

  
ミキサーを作成する際に“Connect automatically as many inputs and outputs as possible”にチェックを入
れると、Pyramixは各トラックの出力と、対応するミキサーのチャンネル入力を自動的にルートします。 
（トラック1の出力をミキサー・チャンネル1の入力，トラック2をミキサー・チャンネル2の入力へルートするなど） 
 
同時に、Pyramixは各ミキサー・チャンネルの出力と、対応するトラックの入力を自動的にルートします。 
（ミキサー・チャンネル1の出力をトラック1の入力，ミキサー・チャンネル2をトラック2の入力へルートするなど） 
 
ステレオのストリップではステレオトラックが作成され、トラック1L/トラック1Rとしてルートされます。  

  
これらトラック入出力のアサインは、トラック・ヘッダー上で簡単に変更することができます。 
 

  
  

トラック表示のハイライト 
トラック・ヘッダーの左端の空白部分をダブルクリックすると、トラック表示の高さを切り替えることができます。ダブ

ルクリックする毎にMini / Medium / Large / Extra Largeとトグルで表示の高さが切り替わります。 
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Trackスケールのズーム 

 

  
トラック表示の左下には、1, 2, 4, 8, 16 および A ボタンがあります。 
各ボタンを押すと、トラックを自動的に垂直方向へスケーリングして、編集パネルの範囲にトラック表示をフィットさ

せて表示します。 
  

ボタンの脇にあるスクロール・バーは、トラックの高さを微調整することができます。 
  
 また、Shiftキーを押しながらマウスホイールを回すことでも調整が行えます。 
  
  

トラック・ヘッダー・パネル 

 トラック・ヘッダー・パネルには様々なコントロール・ボタンと情報が表示されています。 

 
  

トラック・ヘッダーの左上の表示は、トラック出力とミキサーのストリップの接続状態を示しています。 
クリックするとドロップダウンリストが表示され、トラック出力を任意のミキサー・チャンネルへ接続（または接続解

除）することができます。トラック出力とミキサーの接続が解除されている場合、 Off が表示されます。 
 
その隣のボタンは、トラックの名前が表示されます。クリックすると名前の変更が行えます。 
 
2行目の左端のボタンは、入力ソースの接続が表示されます。クリックするとドロップダウンリストが表示され、接続
可能な入力ソースを選択することができます。入力ソースの選択は、ミキサー側へも反映されます。トラックの入力

が何も接続されていない場合、 No Input が表示されます。 
  

ミキサーのチャンネルは複数のトラックへ重複させてアサインすることが可能です。この場合、信号はミキサーへ

入る前にサブMixされます。これにより、ミキサー・チャンネルよりも多くのトラック数を再生することができます。 
  

また、同じ入力ソースを複数のトラックへ接続することも可能です。 
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トラック操作のグループ 
ミキサーのマルチチャンネル・ストリップと接続している場合、トラックは自動的にマルチチャンネルのグループトラ

ックになります。デフォルトで、先頭のトラック・ヘッダーだけに全てのファンクション・ボタンが表示されます。それ

以外のトラックは、トラック構成（L,RやL,R,C,Ls,Rs,Lfeなど）と“+”ボタンが表示されます。この “+”ボタンをクリッ
クすると、トラック・ヘッダーの残りのボタンが表示されます。 
 

ボタンのグループ 

マルチチャンネルのグループトラックでは、トラック・ヘッダーの各ボタン操作が連動します。 
 
以下の装飾キーを組み合わることで、ボタン操作の連動を変更することができます。 

  
z 装飾キーなし  グループトラック全体が連動します。 
z Ctrlキー   グループトラックを無視して個別にトラックを選択できます。 
z Shiftキー  プロジェクト内の全てのトラックが連動します。 
z Ctrl + Shiftキー  グループトラックは無視して、ストリップに連動します。 

（マルチチャンネルやTrackグループに使用すると便利です） 

  

ダイレクトモニタリング 
モニタリング用途のため、これらのストリップへのトラックリターンにはディレイ補正はかかりません。トラック出力を

ミックスダウンする場合は、通常のストリップに接続してください。ダイレクトモニタリングのストリップに接続してい

るトラックは、下図のようにトラックのヘッダー部分に D が表示されます。詳細は、Mixerセクションの“ダイレクトモ

ニタリング”を参照してください。 

 
  
  

トラック・ヘッダーのコンポーネント 

概 要 
トラック・ヘッダーには、様々なボタン操作とインフォメーションが3行になって表示されています。 

トラックの高さが変更されて表示が1行になった場合、最も頻繁に操作されるボタン表示が残って表示されます。 

 

トラックがTrackグループに属している場合、トラック・ヘッダーの上にセパレーターが表示され、上図のように 
 - / + ボタン（非表示/表示の切り替え）とTrackグループの名前（例：Dial）を表示します。 
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 Expand Track Group Trackグループに属しているトラックをすべて表示します。 

 Collapse Track Group  + ボタンで表示させたトラックを折り畳んでコンパクトに表示します。

  

コンポーネント 

1行目 

 

 
左上の番号は、ミキサーのストリップ・チャンネルへの出力アサインを示します。このアイ

コンをクリックするとポップアップ・リストの中から任意のミキサー・ストリップ・チャンネルを

選択できます。アサイン・ナンバーが示されていない場合は、ミキサーへのアサインが選

択されていないことになるので、そのトラックでは録音／再生ができません。 

 
モノ以外のストリップ・チャンネルへアサインしている場合に、チャンネルの種類がトラック

番号の右側に表示されます。トラック番号は昇順に付番されます。 
 ストリップ番号の左側に表示される小さな D は、ダイレクトモニタリングのストリップにア

サインされていることを示します。モニタリング用途のため、これらのストリップへのトラッ

クリターンにはディレイ補正はかかりません。トラック出力をミックスダウンする場合は、通

常のストリップに接続してください 
 トラック・ネームのボタンをクリックすると、テキストボックスが開きます。 

トラック・ネームはデフォルトで左図のようなトラックの種類がついています。 
  

  

Monitorアイコンは、以下の３つの状態で示されます。 

以下の３つのMonitorアイコンはクリックすることで交互に切り替わります。 
 

 
Auto 再生中はRepro、Stop状態で入力ソースを切り替えてモニターします。 

Stop状態での動作は、Settings > All Settings > Application > 
Playback/Recordページの“Auto-monitoring”設定と連動します。 
z European Monitoring (All tracks turn to INPUT on stop)  
z US Monitoring (Only Record Ready tracks turn to INPUT on stop) 

 Repro トラックのReproを常時モニターします。 

 Input そのトラックに接続しているミキサーの入力ソースを常時モニターします。 

  

 /  Mute Muteアイコンをクリックすることで、トラック出力のMuteをOn/Offできます。 

 /  Solo Soloアイコンをクリックすることで、トラック出力のSoloをOn/Offできます。 

 

Peak Meter 
トラック・ヘッダーの右端をクリックすると、Peakメーター表示のOn/Offを切り替
わります。メーターのパラメーターは、Settings > All Settings > Mixer > 
Level Meterのページで設定できます。 

 

Automation  オートメーションの表示をOnにした場合、スケールが表示されます。スケール
は、トラックの高さに応じて表示されます。 
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2行目 

  

 Input source 

入力ソースのアサイン番号を示します。このアイコンをクリックするとポップアップ・

リストの中から任意の入力ソースを選択できます。アサイン・ナンバーが示されて

いない場合は、入力ソースが選択されていません。 

入力アサインは、ミキサー画面からも直接設定することができます。 

 
Playlist 
 

クリックすると、以下のメニューが開きます。 

 
詳細は、Playlistの章をご参照ください。 

  
  

Recordアイコンは、以下の３つの状態で示されます。 

Recordアイコンをクリックすることで、Record Safe／Record Readyが交互に切り替わります。 
ALTキーを押しながらクリックすると、Record Safe／Auto Punch Readyが交互に切り替わります。 

  
Recordアイコンを右クリックするとAll Settings画面が開き、Project > Recordの設定ページが開きます。 

  

 Record Safe 録音が不可能な状態です。 

 Record Ready 
トランスポートのMaster Recordボタンを押すと録音が始まり、Stopボタンまた
はPlayボタンを押すと録音を終了します。 

 Autopunch Ready Master Recordボタンを押すと、設定されているRecord Inポイントに達すると録
音が始まり、Record Outポイントに達すると録音を終えます。 

 Effects 

クリックすると、以下のメニューが開きます。 
 

 
 

リストには、接続しているミキサーストリップに追加されているエフェクト・プラグイ

ンが表示されます。任意のエフェクトを選択すると、そのエフェクト・プラグインのコ

ントロール画面が開きます。 
    

Waveformアイコンは、以下の３つの状態で示されます。 
  

 Display Waveform デフォルトで、クリップはオレンジ色のブロックと白い波形で表示されます。 

 Display Text デフォルトで、クリップはオレンジ色のブロックとテキストラベル（波形なし）で表示

されます。 

 Display Envelope 
デフォルトで、クリップはオレンジ色のブロックと白い波形と黒いエンベロープ線で

表示されます。エンベロープは、マウスでドラッグすることで調整できます。 
Ctrlキーを押しながらマウスをドラッグすると、描画ツールとして機能します。 
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Note: View > Waveform Display > Show Half Waveform / Originメニューを選択すると、波形表示を上半分
のみに切り替えて表示することができます。 

  

 /  
Display 
Waveform 

オートメーション表示のOn/Offが切り替わります。オートメーション・アイコンのエリ
アで右クリックすると、関連するオプション・メニューが表示されます。 

  
  

3行目 

  

 

 
Track Group 

Trackグループの表示と選択ができます。 
ボタンをクリックすると、選択可能なTrackグループがドロップダウンリストに表示
されます。選択したTrackグループの名前は、ボタンに表示されます。Trackグル
ープが選択されていない場合は“No Group”と表示されます。 

 

 

Automation 
Curve 

オートメーション情報の表示と選択ができます。 
ボタンをクリックすると、選択可能なオートメーションのパラメーターがドロップダ

ウンリストに表示されます。選択したパラメーターの名前は、ボタンに表示されま

す。オートメーションのパラメーターが選択されていない場合は“No Automation”
と表示されます。 

 

Add 
Automation 
Sub-track 

Automation Curveボタンの右側に表示されていて、1つのトラックに対して複数
のオートメーション情報を表示させたい場合に使用します。 
 
“+”ボタンをクリックすると、選択可能なオートメーションのパラメーターがドロップ
ダウンリストに表示されます。選択したオートメーション情報は、現在のトラックの

下にAutomationサブ・トラックとして新たに追加表示されます。選択したパラメー
ターの名前は、ボタンに表示されます。 
 
 “-”ボタンをクリックすると、Automationサブ・トラックの表示を削除します。 

  
詳しくは、後述の“Automationサブ・トラック”をご参照ください。 

  
Note: Automationサブ・トラックが表示されている場合、トラック・ヘッダーの左側に小さく青字で A が表示されま
す。このボタンをクリックすると、Automationサブ・トラックの表示/非表示を切り替えることができます。 
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トラックのRecordモード 
 

各トラックには、以下の３つの状態に切り替わる Record Readyのトグル・ボタンがあります。 
 ボタンを右クリックすると All Settings画面が開き、Project > Recordの設定ページが開きます。 
  

Play 
トラック･ヘッダー上のインジケーター表示において、緑色のドット（●）はRecord Safeモードの状態を示していま
す。トラックは録音が不可能な状態です。 

  

Record Ready （マニュアル） 
緑色のドット（●）は、クリックする毎にRecord Readyモードと交互に切り替わります。 
Record Readyモードの状態は、赤色のドット（●）で示されます。 
このモードでトランスポートのMaster Record（●）ボタンを押すと録音がスタートします。 

  

Record Punch In （オート） 
Altキーを押しながら赤色のドット（●）をクリックすると、Record Punch Inモードに切り替わります。 
Record Punch Inモードの状態では、赤色のドットの両脇に縦の赤いラインが入った（|●|）で示されます。 
このモードでトランスポートのMaster Record（●）ボタンを押すと、任意のRecord Inポイントまでトラックを再生
し、Record Inポイントから録音をスタートします。録音は任意のRecord Outポイントに達すると終了し、それ以
降はトラックを再生します。 

 
 
 

Automationトラック 
概 要 
トラックには、オートメーション情報を表示させることができます。1つのトラックに対して複数のオートメーション情
報（ゲイン，ミュート，パンニングなど）を表示させたい場合、トラックの下にAutomationサブ・トラックを追加で表示
することが可能です。また、必要に応じてバスおよびVCAグループのオートメーション情報もトラック上に表示でき
ます。 
 

Automationサブ・トラック 

 
Add Automation 
Sub-track 

Automationサブ・トラックの表示を追加したい場合、トラック・ヘッダーの3行
目の右側にある“+”ボタンをクリックします。選択可能なオートメーションのパ
ラメーターがドロップダウンリストに表示されます。（下図参照） 
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ドロップダウンリストから All… を選択すると、“Select Displayed Automation Track”ダイアログが開いて、 
オートメーション可能なすべてのファンクションがツリー表示されます。  

  

 
  

Hide Empty Tracks チェックすると、オートメーション情報のあるファンクションのみをツリーに表示しま

す。 
Only connected strip / bus トラックに接続されているストリップ情報のみをツリーに表示します。 
Display the selection in 
an extra automation 
sub-track 

チェックすると、選択したファンクションを Automation サブ・トラックに表示します。 

OK 変更を適用してダイアログを閉じます。 

Cancel 選択変更をキャンセルしてダイアログを閉じます。 
  

選択したオートメーション情報は、現在のトラックの下にAutomationサブ・トラックとして新たに追加表示されます。 
選択したパラメーターの名前は、ボタンに表示されます。 
 

  
右側の“+”ボタンをクリックすると、さらにAutomationサブ・トラックの追加と削除が行えます。 
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Automationサブ・トラックが表示されている場合、トラック・ヘッダーの左側に小さく青字で A が表示されます。 
このボタンをクリックすると、Automationサブ・トラックの表示/非表示を切り替えることができます。 

 
 
 

Bus & VCA Groupのオートメーション・トラック 

 トラックには、出力バスおよびVCAグループのオートメーション情報を表示させることができます。 
  

トラック・ヘッダーのトラック番号をクリックすると、ドロップダウンメニューから接続可能なVCAグループおよび出力
バスを選択することが可能です。 

 
  

バスを選択すると、トラック番号のところにバスのID（例：SR1，ST2，A3など）が表示されます。 

 
  

トラック・ネームのところにバスの名前が表示されます。（例：Surround Mix）ただし、変更することはできません。 

 
その他、トラック・ヘッダーにはFXボタン，オートメーション表示ボタン（A），オートメーション情報の名前と+ / -ボタ
ン，Automationサブ・トラックなどが表示されます。 

  
Notes: 
バスに接続したトラック上にあるクリップは再生されません。バスを接続するトラックは、空きトラックを使用するか、

クリップを他のトラックへ移動してください。 
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Tracksタブ画面 

Tracksタブ画面は、各トラックに関する情報をテーブルで表示し、各コラムのフィールドは情報表示と併せて設定
の変更も可能となっています。新しいトラックの作成や既存トラックの削除，トラック位置の変更を行えます。また、

トラックに関わるすべてのパラメーターへアクセスして変更することが可能です。 
  

 
  

新しいトラックを作成するには、タブ画面の一番上の行をクリックして、トラック・ネームを入力しEnterします。 

  
選択したトラックは、Deleteキーで削除できます。 

  
トラックの配置を変更したい場合は、選択したトラックをマウス・ドラッグで移動します。 
一番左のTrackアイコンの位置でドラッグし、任意の位置へ移動してマウスを離してください。 
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Tracksタブのポップアップ 

Tracksタブ内で右クリックすると、下記のポップアップが開きます： 

 
  

Increment Tracks Name 
 

複数トラックのトラック番号を変更できます。 
選択したトラック範囲の一番先頭のトラック番号から昇順に付番します。 

Repeat & Increment Tracks 
Name 

複数トラックのトラック・ネームと番号を変更できます。 
選択したトラック範囲の一番先頭のトラック・ネームをコピーし、残りのトラック名を

上書きします。番号は昇順に付番されます。 

Copy Tracks Name 選択しているトラックのトラック・ネームをコピーします。 
Paste Tracks Name 選択した任意のトラックに、コピーしたトラック・ネームをペーストします。 
Import Tracks Name 選択したトラック（選択がない場合はすべてのトラック）にテキスト・ファイルからイン

ポートしたトラック・ネームを付けます。 
Export Tracks Name 選択したトラック（選択がない場合はすべてのトラック）のトラック・ネームをテキスト

・ファイルとして保存します。 

 

複数のトラックの設定変更 
複数のトラックを選択して設定を変更することができます。隣接した複数のトラックを範囲選択するにはShiftキー
を押しながら、離れているトラックを複数選択するにはCtrlキーを押しながら、任意のトラックをクリックしてくださ
い。 

  

Repro / Input 接続の変更 
コラム・フィールドをクリックすると、ドロップダウンリストから任意の接続を選択できます。 
 
複数のトラックを選択してリストからアサイン先を選ぶと、すべてのトラックに同じ接続がアサインされます。 
また、Altキーを押しながらアサイン先を選ぶと、昇順に選択されたトラックをアサインします。 

 
 
 
 
 
 
 
 
 
 
 



 
 
 

Pyramixユーザーマニュアル  

TrackタブのColumnフィールド 
  

Name トラック・ネームを示します。トラック・ネームをクリックするかF2で、新しい名前を入
力できます。コラム・フィールドには29文字まで表示ができます。 

Repro Connection 
 

ミキサーストリップへの出力アサインを示します。コラム・フィールドをクリックする

と、ドロップダウンリストから任意のミキサー・ストリップ・チャンネルを選択できま

す。ストリップ番号の右側には（）書きでストリップ名が表示されます。 
Input Connection 
 

トラックへの入力ソースを示します。コラム・フィールドをクリックすると、ドロップダ

ウンリストから任意のフィジカル入力または内部リターン・バスを選択できます。 
Group 
 

トラックがTrackグループに属している場合、グループ名を示します。 
コラム・フィールドをクリックすると、ドロップダウンリストから任意のTrackグループ
を選択できます。 

Solo 
 

トラックのSoloがOnの時、YESが表示されます。 
コラム・フィールドをクリックすると、On/Off（＝空欄）がトグルで切り替わります。 

Mute 
 

トラックのMuteがOnの時、YESが表示されます。 
コラム・フィールドをクリックすると、On/Off（＝空欄）がトグルで切り替わります。 

Record Ready 
 

トラックのRecordモードの状態を示します。コラム・フィールドをクリックすると、ド
ロップダウンリストから3つのモードを選択できます。（Safe，Record Ready，
Auto-Punch） 

Monitoring 
 

トラックのMonitorモードの状態を示します。コラム・フィールドをクリックすると、ド
ロップダウンリストから3つのモードを選択できます。（Auto，Input，Repro） 

Hidden タイムライン上でトラックを非表示にした時、YESが表示されます。 
Always Visible 
 

Always VisibleがOnの時、YESが表示されます。 
トラック表示を上下にスクロールしても、表示が保持されます。 

Collapsed 
 

Trackグループに属しているトラックの表示を折り畳んでコンパクトに表示している
時、YESが表示されます。 

Display Mode 
 

クリップのDisplayモードの状態を示します。コラム・フィールドをクリックすると、ド
ロップダウンリストから3つのモードを選択できます。（Block，Waveform，
Envelope）  

Show Automation 
 

トラックのオートメーション表示がOnの時、YESが表示されます。 
コラム・フィールドをクリックすると、On/Off（＝空欄）がトグルで切り替わります。 

Show Peak-Meter トラック・ヘッダーにPeakメーターが表示されている時、YESが表示されます。  
コラム・フィールドをクリックすると、On/Off（＝空欄）がトグルで切り替わります。 

Size トラック表示の高さをピクセルで示します。 
コラム・フィールドをクリックすると、24～511の範囲で値を入力できます。 

Background Color クリップの背景色を示します。空欄になっている場合は、デフォルト色が設定され

ています。コラム・フィールドをクリックすると、カラー・ピッカーがポップアップしま

す。Standardを選択するとデフォルトへ戻ります。 
Waveform Color クリップの波形の色を示します。空欄になっている場合は、デフォルト色が設定さ

れています。コラム・フィールドをクリックすると、カラー・ピッカーがポップアップしま

す。Standardを選択するとデフォルトへ戻ります。 
Recording Media Folder 録音データの保存先に選択されているMediaフォルダを示します。 

コラム・フィールドをクリックすると、現在マウントされているMediaフォルダがドロッ

プダウンリストに表示され、任意のフォルダを選択できます。 
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Trackのエンベロープ&ゲイン調整 

Pyramixでは、トラック・ベースでクリップの音量を調整できる手段として、ゲインとエンベロープのコマンドを備えて
います。 
 
Note: ゲインとエンベロープは、ダイナミック・オートメーションとは無関係に動作します。 
 
 

クリップのゲイン調整 

Gainウィンドウ 
 

Gainウィンドウは、選択したクリップに対してゲインの設定を行えます。 
ゲインの値は、直接ボックスにタイプ入力するか、ストリップのフェーダーをドラッグして移動

することで設定できます。 

 

 
キーボードの↑/↓キーを押すと、0.1dBずつゲインの値を調整できます。 
その他のキーボード・ショートカットについては後述を参照してください。 
 
 
Mute Muteにチェックすると、選択したクリップをミュートします。 

この時、元のゲインの値は保持されます。 
 

Sel. Box 
(Selection) 
 

チェックすると、選択しているクリップ全体にゲインの設定が反映されます。

デフォルトでチェックが入っています。 
 

 

どちらのボックスにもチェックが入っていない場合は、複数のクリップを選択し 

ていても最後に選択したクリップにのみゲイン変更が反映されます。 

 
 
OK  設定の変更を適用してGainウィンドウを閉じます。 

 
Cancel 設定の変更をキャンセルしてGainウィンドウを閉じます。 

 

  

キーボード・ショートカット 

z ↑キー = キーを押すごとに 0.1dBずつ上げます 

z ↓キー = キーを押すごとに 0.1dBずつ下げます 

z Shift + ↑キー = キーを押すごとに 0.5dBずつ上げます 

z Shift + ↓キー = キーを押すごとに 0.5dBずつ下げます 

z Ctrl + Shift + ↑キー = キーを押すごとに 1.0dBずつ上げます 

z Ctrl + Shift + ↓キー = キーを押すごとに 1.0dBずつ下げます 
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エンベロープ調整 

すべてのクリップにおいて、エンベロープは常にデフォルト値の 0dBでアクティブ状態になっています。 
 
エンベロープを調整するには、トラック・ヘッダーの Waveform アイコン（ W ）をクリックで Display Envelope
（ E ）に切り替えてトラック上にエンベロープを表示させます。 

  

 
Display Envelope デフォルトで、クリップはオレンジ色のブロックと白い波形と黒いエンベロープ線で

表示されます。エンベロープは、マウスでドラッグすることで調整できます。 
Ctrlキーを押しながらマウスをドラッグすると、描画ツールとして機能します。 

  
Note: エンベロープ・ポイントはオートメーション・ポイントに似ていますが、エンベロープ・ポイントは■で表示され
ます。 

  

 
 
エンベロープのラインの上にマウスカーソルをのせると、上図のようにカーソル表示が変化します。エンベロープを

調整している間は、カーソル付近にガイドが表示され、エンベロープ・ポイントのレベル情報を確認することができ

ます。ガイドの右側に表示されるタイムコード情報は、現在のクリップの先頭からの位置情報を示しています。 
  

Note: エンベロープ・ポイント（■）をダブルクリックすると、デフォルト値の0dBに戻ります。 
  

マウス操作と装飾キー 

左クリック  新しいエンベロープ・ポイントを作成します。 

Ctrl + クリック  
範囲選択をしてエンベロープのトリムを調整します。 

必要に応じて、新しいエンベロープ・ポイントが自動作成されます。 

Alt + クリック  フリーハンドでエンベロープ・カーブを調整できます。 

Shift + クリック  
エンベロープ・ポイントを微調整します。 
（dB値は0.1dBステップで変動） 

V + クリック  
エンベロープ・ポイントの時間軸をずらさずに垂直方向へエンベロープ値を

調整できます。 

H + クリック  
エンベロープ・ポイントのエンベロープ値をずらさずに水平方向へ時間軸を

調整できます。 

クリックホールド + Alt  
既存のエンベロープ・ポイントを左クリックでホールドしたまま 

Altキーを押してマウスを移動すると、次のエンベロープ・ポイントと 

同じ値に調整できます。 
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クリックホールド + Ctrl  
既存のエンベロープ・ポイントを左クリックでホールドしたまま 
Ctrlキーを押してマウスを移動すると、前のエンベロープ・ポイントと 
同じ値に調整できます。 

Ctrl + Alt + クリック  既存のエンベロープ・ポイントを削除できます。 

 

Envelopeカーソル 
  

 
オーディションカーブ上で左クリックすると、新しいエンベロープ・ポイントが作成されます。

 
既存のエンベロープ・ポイントを左クリックすると、ポイントを調整できます。 

 
範囲選択をしてCtrl +クリックすると、エンベロープのトリムを調整できます。 

 
エンベロープ・カーブでAlt +クリックすると、フリーハンドでエンベロープを調整できます。 

 

既存のエンベロープ・ポイントをCtrl + Alt +クリックすると、ポイントを削除できます。 

  
  

Envelopeメニューのファンクション 
Clips > Envelopeメニューには、エンベロープに関する各ファンクションが表示されます。 
 

 
 
Envelope Reset 選択しているトラック上で、セレクション範囲のエンベロープ情報をリセットしてデフォ

ルト値に戻します。 
Envelope Reset 
Selection 

セレクション範囲が設定されているすべてのトラックでEnvelope Resetを実行しま
す。 

Envelope Copy to 
Selection 

選択しているトラック上で、セレクション範囲のエンベロープ情報をコピーして、セレ

クション範囲が設定されている他のトラックへコピーします。 
Envelope Punch 選択しているトラック上で、任意のクリップのエンベロープ情報にPunch Envelope

（後述参照）を実行してエンベロープをトリム調整します。 
メニューを選択すると、Punch Envelopeダイアログが開きます。 

Envelope Punch 
Selection 

クリップが選択されているすべてのトラックでPunch Envelopeを実行します。 
メニューを選択すると、Punch Envelopeダイアログが開きます。 
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Punch Envelope 
Punch Envelopeは、1つのクリップの中でたくさんのゲイン調整が必要な場合（ダイアログ編集など）に、便利な
手段です。 

  
Clips > Envelopesメニューを選択するか、ショートカットの Ctrl + P または Ctrl + SHIFT + P でダイアログを
表示します。 

 
  

Punchのフィールドにゲインの変更値を入力します。（ゲインを下げたい場合は、最初に“-”を入力します） 
パンチの前後にフェードを加えたい場合は、Fadeのフィールドにmsで必要な長さを入力します。 
 
OKボタンは、変更を実行してダイアログを閉じます。 
Cancelボタンは変更をキャンセルしてダイアログを閉じます。 
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Trackグループ 

Trackグループを作成すると、グループ化した複数のトラックに対してファンクションを効率良く適用することができ
ます。 

  
Note: Tracksタブのフィールドからドロップダウンメニューを使用してTrackｋグループを追加することもできます。 

  

 Track Groupsタブ画面 
Track Groupsタブ画面は、各Trackグループに関する情報をテーブルで表示し、各コラムのフィールドは情報表示
と併せて設定の変更も可能となっています。 

 
 
最初の行にある“Click here to add a new Track Group”は、新しいTrackグループを作成するのに使用します。
２行目の “Click here to duplicate a Track Group”は、既存のTrackグループを複製するのには使用します。 

  
新しいTrackグループを作成するには、タブ画面の一番左上にある“Click here to add a new Track Group”を
クリックします。グループの名前を付けるボックスが現れるので、適当な名前を入力してエンターしてください。 
新しいTrackグループは、リストの一番下に追加されます。 

  
既存のTrackグループを複製するには、任意のTrackグループを選択した状態で“Click here to duplicate a 
Track Group” をクリックします。グループの名前を付けるボックスが現れるので、適当な名前を入力してエ
ンターしてください。複製されたTrackグループは、コピー元のTrackグループのすぐ下に追加されます。 
 
リスト表示の順番を変更したい場合は、Trackグループ名の一番左に表示されているアイコンをクリックしてから、
任意の位置へドラック移動してください。 

  
タイムライン上におけるTrackグループの割り当ては、Trackグループに属する先頭トラックのトラック・ヘッダーの
上に表示されます。 

  
Trackグループに属するトラックの表示は、先頭トラックのトラック・ヘッダーの上にある + / - アイコンをクリックす
ることで、１つのトラックに折り畳んで表示／全表示と切り替えられます。 

 
  

Track GroupタブのColumnフィールド 

  
Name Trackグループの名前を示します。トラック・ネームをクリックするかF2で、新しい

名前を入力できます。コラム・フィールドには29文字まで表示ができます 

Type 
 

z Free 
z Source 
z Destination 

コラム・フィールドをクリックすると、ドロップダウンリストから3つのタイプを選択でき
ます。（Free，Source，Auto- Destination） 
一般のTrackグループとしてトラックを分類します。（デフォルト値） 
Source/Destination編集のSourceとしてトラックを分類します。 
Source/Destination編集のDestinationとしてトラックを分類します。 
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Collapsed Trackグループの表示を折り畳んで、グループのトラック１つだけを表示します。 
Yesにすると、Collapsed Displayで選択したトラックのみをタイムライン上に表示
して、グループの他のトラックは非表示になります。 
このフィールドは、トラック・ヘッダーの+ / - アイコンと同じ動作をします。 

Collapsed Display コラム・フィールドをクリックすると、ドロップダウンリストからTrackグループ属する
トラックを選択できます。CollapsedフィールドをYesにした場合、ここで選択したト
ラックが表示されます。 

  

その他のフィールド 
その他のコラム・フィールドは、クリックする毎にYesと空白がトグルで切り替わります。 
以下の機能は、Yesが設定された時に適用されます。 

  
Keep Cursor Trackグループを選択した状態で移動したPlayカーソルの位置をキープし、（他の

トラックへ選択を移動した後で）再度Trackグループを選択した際、その位置を呼
び出します。 

Free Zoom 設定したTrackグループのZoom操作は、他のトラックと独立して動作します。 
Free Markers Yesにすると、Trackグループの先頭トラックの上にマーカーのスペースが表示さ

れ、設定したTrackグループは独立したマーカー・リストを作成できます。 
Markers Locked Free Markersによって設定したTrackグループのマーカーをロックします。 
No Selection 設定したTrackグループにおいて、マウス・クリックによるクリップの選択を不可能

にし、Playカーソルの位置を移動させます。クリックを選択するには、Playカーソル
をクリップ上へ移動して、Qキーを押してください。 

Auto Solo 設定した Trackグループを選択した時に、Trackグループ全体を自動的に Soloに
します。 

Auto Mute 設定したTrackグループがトラックの選択から外れる時に、Trackグループ全体を
自動的にMuteにします。 

Auto Record Ready 設定したTrackグループを選択した時に、Trackグループ全体を自動的にRecord 
Readyモードにします。 

Auto Collapse Trackグループがトラックの選択から外れる時に、Trackグループ全体の表示は自
動的に１つのトラックに折り畳まれます。Trackグループを選択すると、Trackグル
ープ全体が表示されます。 

Auto Hide Trackグループがトラックの選択から外れる時に、Trackグループ全体は自動的に
非表示となります。Trackグループを選択すると、Trackグループ全体が表示され
ます。 

Exclusive Show 設定したTrackグループを選択した時に、それ以外のすべてのトラックが自動的に
非表示となります。トラック表示に対するSoloのような機能です。 

Show Scale Free MarkersあるいはFree Zoomモードが設定されている場合、Trackグループ
の先頭トラックの上に独立したTimeCodeスケールを表示します。 
設定がOFFの場合は、Trackグループを選択した時、メインのTimeCodeスケール
上の表示でマーカーとZoomを示します。 

Selection Yesにすると、タイムライン上でのセレクションをTrackグループ全体に適用しま
す。デフォルトでは、無効になっています。 

 
その他のコラム（Solo, Mute, Record, Monitoring, Display, Show/Hide, Size, Color, Sync, Automation 
Display）は、トラック・ヘッダーまたは Track タブ画面で設定した状態が Trackグループ毎に連動します。 
例： Trackグループに属する１つのトラックを Soloにした場合、Trackグループ全体が Soloになります。 
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